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Program Credits 
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All rights reserved.

Rimrock Software
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RIME was written using Borland Delphi. The program's E-mail component was written by 
StarTech. The bust of Mercury was drawn by Bob Banger.

Borland International - http://www.borland.com
Bob Banger - rebanger@eznet.com

StarTech - http://www.neosoft.com/~startech/delphi/delphi.htm



RIME Introduction 
RIME is an Internet E-mail program that is capable of sending the same e-mail message to 
multiple locations using a bulk address list. RIME can merge specific information for each 
address into the message before sending it. You can send personalized messages to your 
customers, to your relatives or to your user group with minimal effort.

RIME is easy to use. You load an address list, load a text file and enter a subject. Then select 
the people you want to send the text to and click on the 'Send Mail' button. Presto, instant 
personalized E-mail!

 For instance, suppose the bulk address list had the following lines in it:

michaelb@rand.nidlink.com,Mr.,Michael,Burton
johnsmith@whoknows.org,Mr.,John,Smith

Also suppose that the text to be sent looks like this:

Dear %1 %3,
This is a test of RIME's mail merge capability, %2.

When RIME sends this message to michaelb@rand.nidlink.com, it will look like this:

Dear Mr. Burton,
This is a test of RIME's mail merge capability, Michael.

When RIME sends this message to johnsmith@whoknows.org, it will look like this:

Dear Mr. Smith,
This is a test of RIME's mail merge capability, John.

Argument zero (%0) is always the e-mail address of the recipient. The other arguments can 
be anything you want. You can supply up to 9 arguments (%1 through %9).



 How to Use RIME 
There are four steps involved in using RIME to send e-mail:

1. Load a Bulk Address (.BAD) file into RIME.

2. Load a text file into RIME, or create one using the built-in text editor. The text file 
should not contain any illegal characters.

3. Supply a subject for the message to be sent.

4. Select one or more addresses in the Bulk Address file as message destinations. Use the 
shift and control keys in combination with your mouse to select multiple addresses, or use the
Mark All button to select all addresses.

When you have completed these four steps, the 'Send Mail' button is enabled, allowing you to
send the message to the selected addresses.

(You must, of course, also have a valid connection to the Internet in place when you click on 
the 'Send Mail' button.)

When you click the 'Send Mail' button, RIME will display the Send Mail dialog

 
    Note: You must also have filled out at least four of the fields in    the Options | Program 
Information dialog before the Send Mail button    will work. The fields are first name, last 
name, e-mail address and    SMTP server. See the Program Information Dialog help    for 
more information. 



RIME Menu Commands 

Point to the item you want help on and click the mouse button.



 Mail-merge Variables 
RIME's mail-merge variables allow you to customize each message you send, so the recipient
assumes it is a personal message. There are 15 variables you can place in your text; 10 of 
them are extracted from the bulk address list, and the remaining 5 are extracted from the 
personal information you entered into RIME.

Bulk Address Variables

Each bulk address field is separated by a delimiter. The default delimiter is a comma (,). 
Obviously, each field cannot have a delimiter in it. The fields are numbered 0-9.

• %0 Always contains the receiver's e-mail address.
• %1 thru %9 Contains any information you want.

Personal Information Variables

• %first Your first name.
• %last Your last name.
• %email Your e-mail address.
• %http Your Web page address.
• %misc Any text string you care to define.



Internet E-mail Etiquette 

Do not use RIME to send unsolicited or junk mail to people you are 
not acquainted with. Do not use RIME to send multiple copies of the 
same message to the same person (spamming). Rimrock Software 
will not be responsible for the consequences of such actions.

The following information was extracted from RFC 1855, Netiquette Guidelines. The entire 
document is available at:

     http://www.cis.ohio-state.edu/htbin/rfc/rfc1855.html

Please pay special attention to items in red type.

2.1 User Guidelines

2.1.1 For mail:

Unless you have your own Internet access through an Internet provider, be sure to check 
with your employer about ownership of electronic mail. Laws about the ownership of 
electronic mail vary from place to place.

Unless you are using an encryption device (hardware or software), you should assume that 
mail on the Internet is not secure.    Never put in a mail message anything you would 
not put on a postcard.

Respect the copyright on material that you reproduce.    Almost every country has copyright
laws.

If you are forwarding or re-posting a message you've received, do not change the wording.  
If the message was a personal message to you and you are re-posting to a group, you 
should ask permission first.    You may shorten the message and quote only relevant 
parts, but be sure you give proper attribution.

Never send chain letters via electronic mail.    Chain letters are forbidden on the Internet.    
Your network privileges will be revoked.    Notify your local system administrator if 
your ever receive one.

A good rule of thumb:    Be conservative in what you send and liberal in what you receive.   
You should not send heated messages (we call these "flames") even if you are 
provoked.    On the other hand, you shouldn't be surprised if you get flamed and it's 
prudent not to respond to flames.



In general, it's a good idea to at least check all your mail subjects before responding to a 
message.    Sometimes a person who asks you for help (or clarification) will send 
another message which effectively says "Never Mind".    Also make sure that any 
message you respond to was directed to you.    You might be cc:ed rather than the 
primary recipient.

Make things easy for the recipient.    Many mailers strip header information which includes 
your return address.    In order to ensure that people know who you are, be sure to 
include a line or two at the end of your message with contact information.    You can 
create this file ahead of time and add it to the end of your messages.    (Some mailers do
this automatically.)    In Internet parlance, this is known as a ".sig" or "signature" file.    
Your .sig file takes the place of your business card.    (And you can have more than one 
to apply in different circumstances.)

Be careful when addressing mail.    There are addresses which may go to a group but the 
address looks like it is just one person.    Know to whom you are sending.

Watch cc's when replying.    Don't continue to include people if the messages have become 
a 2-way conversation.

In general, most people who use the Internet don't have time to answer general questions 
about the Internet and its workings. Don't send unsolicited mail asking for information 
to people whose names you might have seen in RFCs or on mailing lists.

Remember that people with whom you communicate are located across the globe.    If you 
send a message to which you want an immediate response, the person receiving it might
be at home asleep when it arrives.    Give them a chance to wake up, come to work, and 
login before assuming the mail didn't arrive or that they don't care.

Verify all addresses before initiating long or personal discourse. It's also a good practice to 
include the word "Long" in the subject header so the recipient knows the message will 
take time to read and respond to. Over 100 lines is considered "long".

Know whom to contact for help.    Usually you will have resources close at hand.    Check 
locally for people who can help you with software and system problems.    Also, know 
whom to go to if you receive anything questionable or illegal.    Most sites also have 
"Postmaster" aliased to a knowledgeable user, so you can send mail to this address to 
get help with mail.

Remember that the recipient is a human being whose culture, language, and humor have 
different points of reference from your own.    Remember that date formats, 
measurements, and idioms may not travel well.      Be especially careful with sarcasm.

Use mixed case.    UPPER CASE LOOKS AS IF YOU'RE SHOUTING.

Use symbols for emphasis.    That *is* what I meant.    Use underscores for underlining. 



_War and Peace_ is my favorite book.

Use smileys to indicate tone of voice, but use them sparingly. :-) is an example of a smiley 
(Look sideways).    Don't assume that the inclusion of a smiley will make the recipient 
happy with what you say or wipe out an otherwise insulting comment.

Wait overnight to send emotional responses to messages.    If you have really strong 
feelings about a subject, indicate it via FLAME ON/OFF enclosures.    For example:

FLAME ON:    This type of argument is not worth the bandwidth it takes to send it.    It's 
illogical and poorly reasoned.    The rest of the world agrees with me.

FLAME OFF

Do not include control characters or non-ASCII attachments in messages unless they are 
MIME attachments or unless your mailer encodes these.    If you send encoded 
messages make sure the recipient can decode them.

Be brief without being overly terse.    When replying to a message, include enough original 
material to be understood but no more. It is extremely bad form to simply reply to a 
message by including all the previous message: edit out all the irrelevant material.

Limit line length to fewer than 65 characters and end a line with a carriage return.

Mail should have a subject heading which reflects the content of the message.

If you include a signature keep it short.    Rule of thumb is no longer than 4 lines.    
Remember that many people pay for connectivity by the minute, and the longer your 
message is, the more they pay.

Just as mail (today) may not be private, mail (and news) are (today) subject to forgery and 
spoofing of various degrees of detectability. Apply common sense "reality checks" 
before assuming a message is valid.

If you think the importance of a message justifies it, immediately reply briefly to an e-mail 
message to let the sender know you got it, even if you will send a longer reply later.

"Reasonable" expectations for conduct via e-mail depend on your relationship to a person 
and the context of the communication. Norms learned in a particular e-mail 
environment may not apply in general to your e-mail communication with people 
across the Internet.    Be careful with slang or local acronyms.

The cost of delivering an e-mail message is, on the average, paid about equally by the 
sender and the recipient (or their organizations). This is unlike other media such as 
physical mail, telephone, TV, or radio.    Sending someone mail may also cost them in 
other specific ways like network bandwidth, disk space or CPU usage.    This is a 
fundamental economic reason why    unsolicited e-mail advertising is unwelcome (and 



is forbidden in many contexts).

Know how large a message you are sending.    Including large files such as Postscript files 
or programs may make your message so large that it cannot be delivered or at least 
consumes excessive resources.    A good rule of thumb would be not to send a file larger
than 50 Kilobytes.    Consider file transfer as an alternative, or cutting the file into 
smaller chunks and sending each as a separate message.

Don't send large amounts of unsolicited information to people.

If your mail system allows you to forward mail, beware the dreaded forwarding loop.    Be 
sure you haven't set up forwarding on several hosts so that a message sent to you gets 
into an endless loop from one computer to the next to the next.



 RIME Registration and Upgrades 
The evaluation configuration of RIME has some limitations. This was done to allow you to 
evaluate all of RIME's features and still encourage you to register the program. Specific 
differences between the evaluation configuration and the registered configuration are:

Evaluation Configuration

• Registration reminder screen with 10 second delay and audio reminder
• Limited to transmitting to five recipient addresses
• Registration reminder placed on all printed messages
• Registration reminder placed on transmitted messages
• Test RIME menu item in Options menu
• RIME order form menu item in Help menu
• Registration ID menu item in Help menu

Registered Configuration

• Registration reminder screen and audio reminder removed
• Transmit to 32,700 recipient addresses
• No registration reminder on printed messages
• No registration reminder on transmitted messages
• Test RIME menu item removed
• Order form menu item removed
• Registration ID menu item removed

Registration is $25. You can fill out a registration form in RIME by selecting the Help | 
RIME Registration Form menu item, or use the order form built into this help file. If you 
are paying with a credit card, you have the option of sending the registration form via 
encrypted E-mail directly to Rimrock Software. A registration ID will be E-mailed back to 
you, usually within 24 hours (unless we are at a software conference or it's a holiday).

If you chose to send the form via normal mail, we will snail-mail the registration ID back to 
you.

In any case, once you have registered RIME, you are entitled to free upgrades from our Web 
site, until the next major revision is created. Any time you download an upgrade, you do not 
need to re-enter the registration ID - it will automatically be recognized.



The Bulk Address File 
The Bulk Address File contains the E-mail addresses and other information of the people 
who will be receiving your E-mail messages. Each line of the file contains information about 
one person, and the line is broken up into pieces called fields.

Each bulk address field is separated by a delimiter. The default delimiter is a comma (,), but it
can be any character, as long as that character doesn't occur inside any of the fields. The 
fields are numbered %0 through %9. The person's E-mail address is always field zero (%0). 
We've numbered each field of the example below to show how they are referenced in your 
text:

           %0               %1     %2     %3
  michaelb@rand.nidlink.com,Mr.,Michael,Burton
  johnsmith@whoknows.org,Mr.,John,Smith

Note that this example only has four fields in it, separated by the default comma delimiter. 
You could just as easily have ten fields, separated by colons (like a UNIX password file).



 Program Information Required fields 

Point to the item you want help on and click the mouse button.

The Program Information Dialog allows you to enter information that is necessary for RIME 
to accomplish its E-mail function. This information need only be entered once. RIME will 
remember it and use it each time you use the program.



 Program Information Optional fields 

Point to the item you want help on and click the mouse button.



The Program Information Configuration fields 

Point to the item you want help on and click the mouse button.



Enter your first name here. This is a required field that is used in the E-mail header and can 
be used (as %first) anywhere in the E-mail text file.



Enter your last name here. This is a required field that is used in the E-mail header and can be
used (as %last) anywhere in the E-Mail text file.



Enter your Internet E-mail address here. This is a required field that is used as the 'from' 
address of the E-mail message and can be used (as %email) anywhere in the E-mail text file.



If you have one, enter your Web page URL here. This is an optional field which can be used 
(as %http) anywhere in the E-mail text file.



Enter any miscellaneous text you would like in this field. This is an optional field which can 
be used (as %misc) anywhere in the E-mail text file.



Enter the name of your mail server here. This is a required field that tells RIME what server 
to use to send the E-mail from.



Enter the mail port number here. The default is 25, which can be used in 99% of all cases. A 
valid number must be present in this field.



Enter the character that you will use to separate fields in your Bulk Address Files. The default
is a comma.



Click on this button when you have finished filling out the information in this dialog.



Click on this button if you decide not to make any changes to the information in this dialog.



Click on this button to view this online help.



You have a choice as to how you want the addresses in the Bulk Address list box displayed. 
Choose the one you are most comfortable with. Your choice will be saved and used the next 
time you use RIME.



The Order Form Dialog 
The RIME Order Form Dialog is used when you want to register RIME and remove the 
shareware constraints from the program.

Point to the item you want help on and click the mouse button.



Enter your first name here. If you have filled in the information in the Program Information 
dialog, this field will already contain your first name.



Enter your last name here. If you have filled in the information in the Program Information 
dialog, this field will already contain your last name.



Enter your company name here.



Enter the first line of your postal address here.



Enter the second line of your postal address here.



Enter your city name here.



Enter the name of your state or province here.



Enter your zipcode or country code here.



Enter the name of your country here. If you live in the U.S., this is optional.



You may optionally enter your phone number here. Please include area and/or country codes.



You may optionally enter your Fax phone number here. Please include area and/or country 
codes.



Enter your E-mail address here. If you have filled in the information in the Program 
Information dialog, this field will already contain your E-mail Address.



You may optionally enter your Web URL here. If you have filled in the information in the 
Program Information dialog, this field may already contain your Web URL.



Chose a payment method with these buttons. If you chose payment by VISA or Mastercard, 
you can either print the order form or send it directly to Rimrock Software by encrypted E-
mail.



If you chose payment by credit card, enter the card number here.



If you chose payment by credit card, enter the card's expiration date here.



You may enter any suggestions you have for improving RIME in this memo field.



You may enter any general comments or bugs in this memo field.



This button is enabled if you choose payment by credit card. When this button is clicked, 
RIME will encrypt your order information and send it as an E-mail message to Rimrock 
Software.



When this button is clicked, RIME will print an order form containing the information from 
this dialog.



Click on this button when you have finished with the RIME Order Form. Note: be sure to 
print or send the form before using this button.



Click on this button to view this online help.



The File Menu 

Point to the item you want help on and click the mouse button.



The Edit Menu 

Point to the item you want help on and click the mouse button.



The Search Menu 

Point to the item you want help on and click the mouse button.



The Mail Menu 

Point to the item you want help on and click the mouse button.



The Options Menu 

Point to the item you want help on and click the mouse button.



The Help Menu 

Point to the item you want help on and click the mouse button.



Clear the bulk address list, the text area and the subject box so new information may be 
entered in these areas.



Read a bulk address file into the address list. An open file dialog is displayed to allow you to 
pick a .BAD file.



Read a text file into the text area. An open file dialog is displayed to allow you to pick a text 
file.



Save the text area to a file. A save file dialog box is displayed to allow you to specify a file 
name to save to.



Save the address list to a file. A save file dialog box is displayed to allow you to specify a file
name to save to.



Allows you to print the text file, merged with the last selected    address from the bulk address
list.



Allows you to change the printer you are using, or its configuration.



Leave RIME and return to Windows. If the text file was modified, you will be prompted to 
save it.



Cut the selected text from the text area onto the clipboard.



Copy the selected text from the text area onto the clipboard.



Paste the clipboard to the current cursor position in the text area.



Delete the highlighted items from the Address List.



Add new address lines to the Address List.



Allows you to search for text in the Address box.



Find the next text occurence in the Address box.



Send the message to the selected addresses.



Attach a file to the message when it is sent to each address. The attached file can be of any 
type.



Shows you how to set RIME up for message transmissions.



Invokes the RIME help file and positions at the table of Contents.



Allows you to search for a specific help topic.



Shows you how to use a Windows help file.



Allows you to enter your registration ID, which reconfigures the program from the evaluation
version to the registered version.



Displays a dialog containing program information.



RIME Registration Form 

RIME Order Form

[X] Please send me a Registration ID for the RIME Internet Mail-merge E-
mailer. I have enclosed the $25 registration fee (check/cash or credit 
card). I understand that using the Registration ID will disable all the 
evaluation limitations of the program.

Please register RIME v1.40 to:

Name:    ___________________________________________
Company: ___________________________________________
Addr1:   ___________________________________________
Addr2:   ___________________________________________
City:    _________________ State/Prov: _____________
Zip/Postal code: ___________________________________
Country: ___________________________________________
Phone:   ___________________________________________
FAX:     ___________________________________________
E-mail:  ___________________________________________
URL:     ___________________________________________

Payment Type:
Check [ ]  Cash [ ] Credit card [ ]
Card type: VISA [ ] Mastercard [ ]
Expiration date: ___________________________________
Cardholder Signature: ______________________________

Send completed for with payment to:

  Rimrock Software
  P.O. Box 2406
  Hayden, ID  83835-2406
  USA

=========================================================
Please send your registration by check drawn on a U.S. bank and made 
payable to Rimrock Software.

Your registration ID will be sent to you via E-mail or first class mail as 
soon as possible following receipt of your registration payment.

If you have any questions or comments about RIME, you may reach us by 
telephone at 208-772-9347, or by E-mail at rimrock@rimrocksoftware.com



Simple Mail Transfer Protocol (SMTP) can only handle the regular ASCII character set. Any 
characters with values above 127 are considered illegal. If there are any such characters in a 
RIME text file, the file will be encoded so that the characters are no longer illegal.



The Send Mail Dialog 

Point to the item you want help on and click the mouse button.



Displays how many addresses you will be sending this e-mail message to.



Displays how many addresses you have already sent the e-mail message to.



Displays status of the current message you are sending, including anyerror messages. This 
status is optionally captured in RIME.LOG.



If checked, the sending dialogs will be captured in RIME.LOG.)



Establishes the priority of the messages you will be sending. Some mail readers (such as 
Eudora) can use this priority to inform their users of the importance of the message.



Starts the e-mail transmission process.



Stops the e-mail transmission process, after the current message is sent.



Closes the Send Mail dialog and returns to the RIME window.






